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About this User’s Guide

This guide explains the image processing method and a method of Raster Link Pro II settings
to remove colors (discharging) from T-shirts dyed by the GP-604D / GP-1810D.
For basic methods of Raster Link Pro II handling, see the Reference Guide.

Notations

Menu items are enclosed in quotation marks like “ Discharge Composition”.

Buttons in dialog box are framed like .
Symbol

indicates a caution you should pay attention.

Notice

e [t is strictly prohibited to write or copy a part or whole of this document without our approval.

e The contents of this document may be subject to change without notice.

¢ Due to improvement or change of this software, the description of this document could be partially
different in specification, for which your understanding is requested.

e It is strictly prohibited to copy this software to other disk (excluding the case for making backup) or
to load on the memory for the purpose other than executing it.

e With the exception of what is provided for in the warranty provisions of MIMAKI ENGINEERING
CO., LTD., we do not assume any liability against the damages (including but not limited to the loss
of profit, indirect damage, special damage or other monetary damages) arisen out of the use or fail-
ure to use of this product. The same shall also apply to the case even if MIMAKI ENGINEERING
CO., LTD. had been notified of the possibility of arising damages in advance. As an example, we
shall not be liable for any loss of the media (works) made using this product or indirect damages
caused by the product made using this media.

Adobe, the Adobe logo, Photoshop, Illustrator and PostScript are trademarks of Adobe System Incorporated.
All brand names and product names are trademarks or registered trademarks of their respective companies.
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Discharging method

There are several discharging methods as follows:

Printing only by discharge liquid

Print the image by using only the discharge liquid.

Create a monochrome image as the original image.

,/// .

Original image Printing -> Post processing

Printing simultaneously with color image

Print the color ink and the discharge liquid simultaneously.

If a colored T-shirt is printed with only the color ink, the image does not stand out. Printing by
simultaneously using the discharge liquid removes the color on the T-shirt, and the color ink
obtains good color development.

Printing with only the color ( Printing simultaneously with
ink shows poor color develop- the discharge liquid removes
ment due to the base color. the base color,and the color ink

obtains good color develop-
ment.




Printing with only discharge liquid

Printing with only discharge liquid

Changing color of printed image for discharging

When the image to be printed has color data, select “Gray scale” (expressing the image by
only the black) for the color of the image data.

( )
Gray-scale image and finish

The discharge liquid is coated most to the darkest portion within the gray-scale
image to be printed. That is, the darkest portion of the original gray-scale image is
discharged most when finished.

Example)

The image on the right is used as
the original image.

Middle

Dark

Printing

A

The image is printed on a colored
T-shirt by using the discharging
agent, and then postprocessing is
executed.

After printing,

@ post process-

ing is executed.
As shown on the right, the darkest
colored portion of the original . Light
image is discharged most. ‘ e

. Dark

For ordinary printers, a dark portion of the image is printed darkly. However, as a
result of printing with the discharge liquid and postprocessing, dark portions of the
original image are printed light, and light portions are printed darkly. That is, con-
trasting density of original image appears inversely. Therefore, the image to be
printed requires and black inversion before printing.




Processing method for Photoshop

This section explains the methods to process the image to a gray-scale image by using Photo-

shop 6.

Open the image to be edited by using ~ [EETEEEG—_—_—_—
Photoshop.

Qs ipeeriates | _pcusous | _rnonserwn | _prmmses

B Cick o drsg ovar the sres you want o afarge Prace ALT fo aom cat

2 Select [Image] - [Mode] - [Grayscale] (s

File Edit BUELEN Laver Select Filter View Window Help

22:2( Scloc

from the menu.

>
=

—
Duplicate... Indexed Color...
=Ty, Apply Image. .. v RGE Color
il 7| Cakculations... CMYK Color
1N 5 Lab Color
t‘ , Image Size... Multichannel
C Canvas Size...
A F)  Rotate Canvas ¥ v 8Bits/Channel
& % 16 BitsfChannel
M2 ZLIET |
oo T
0. | e Assign Profile. ..
kT = Convert to Profile...
¢l0
D / Extract...  Al+Ctrl+X
([ Q| Uy, Shicecubex

]

3 Shown the “Discard color informa-
.o Adobe Photoshop
tion?”” message box.

Click | OK |. "f Discard color information?

-grici

™ Don’t show again




Printing with only discharge liquid

Be ER Inage Lwer Soht Fer Yo Window teb

4 The image is converted into a gray- [

Q[ Resea Wndows TPl [ e Puties | ActnlPils | FiOn Sarsen | _ Print Sze

scale image.

Invert the colors of the image. = Adobe Photoshop
File Edit BUEECH Laver Select Filker Yiew Window Help

elect [Image] - [Adjust] - [Invert] from th
S [ ge] - [Adjust] - [Invert] fro © Q| r_te * brauttes | actuaPixds | FitonScreen | _printSie |
menu. o B Leves.. CtrbeL
‘_' = futo Levels Shft+CtriL
EZ= ;::;"mge Buto Contrast  Alt+Shft+CtriHL
i—; :“’ caleulations.... Clwyes.. o ity
N :
- Image Size... Erightnessf/Contrast...
ﬁ " Canvas Size...
% ﬂ'. Rntatgc_alwas »
%. I% Teime., R_aplac.e Cdﬂh...
Hi Gradient Map...
: (T Select
D[] Bttt BleCEHY ihre;r;;rd...
Q| loufy.. ShiteCerex Postefize...
S Variations. ..
]
= =]
e
6 The colors are inverted. < ey
B B [nage Laer et Fller Yaw Window b

Q CrRazewnswiTert [ ieesPuites  AcuuPats | FtOnserssn | prmtsiee

Gray)

Save the image.

[ 23335 | boc: 277M/277M0 B Chck or drag aver fhe ars you want b riarge Press ALT to zsom eut




Processing method for Illlustrator

This section explains the methods to process the image to a gray-scale image by using Illustrator 10.

There are two methods for processing to a gray-scale image by using Illustrator:

Common operations

Open the image to be edited by USiIlg (3 Adobe llustrator - [SYIKOD3.eps @ 150% (CHYKPreview) | Ex

ﬂgﬂe Edit Object Type Select Fiter Effect View Window Help =& x

[lustrator.

1

e Ny A
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”
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=
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SN E |
%
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Om =
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[1s0% | 200m Rakl| 1| »

When the color mode Of the image iS {3 Adobe Illustrator - [SYIK003.eps ® 150% (CMYK/Pr]
File Edit Object Type Select Filter Effect View Winc

“RGB,” convert it into “CMYK”. 1 New.. i

Open... Ctri+0
Open Recent Files »
Revert F12
. Close Chrl+w
NOTE] The_ color mode of the image = aws
is displayed as (RGB) or pic s e

Save for Web...  Ctrl+Shift+Alt+S

(CMYK) on the title bar. —
Select [File] - [Document Color Mode] st \Q R

- [CMYK Color] from the menu. (- oo )———( Select)

File Info... T
Separation Setup...

Print Setup... Ctrkshift+p

Print... Ctrl+P

Exit Ctl+Q

150% T zoonr vl

3 Selectall objects.
8 x

ﬂﬂ\e Edit Object Type Select Fiker Effect View Window Help =

150% v Selection




Printing with only discharge liquid

A. Converting to gray-scale image with vector objects left as is

1 Select [Filter] - [Colors] - [Convert to Effect View Window Help -8 x
Grayscale] from the menu. _ ﬁ TR =
Aot Colors..
Create »|  Blend Front to Back
Distort »|  Blend Horizontally
Pen & Ink »  Blend Vertically
Stylize ¥ Convert bn CMVK
"
Artistic N
glur h Stroke. : Invert Colors
rush Strokes Overprint Black( Select
Distort »
i Saturate...
P;:(elate > e -
Sharpen »
Sketch R ESIgE
Stylize > } A
Texture 4 P4
Video » L. T
A

9 The image is converted into a gray-

)
EE:

1 . ﬂgﬂe Edit Object Type Select Fiter Effect View Window Help =
Scalc 1mage. - — , . -
=
/ / 1R,
Y. | R
¥ @,
N, &,
& 2.
0.8,
2, %1
> B, b, | _|
il a
] 2%,
o Fe<,
LA
a
?
g vail
Olm &
EEE
[1s0% -] Selection Rkl 1] »
3 Invert the colors of the image. Effect View Window Help
1 Apply Invert Colors  Ctrl+E
. A | t Col Ctrl+Alt+E [«
Select [Filter] - [Colors] - [Invert rentees | [
Colors 4 Adjust Colors...
Colors] from the menu. Create ,
Distort »
Pen & Ink »
Stylize »  Convert to CMYK
L Convert to Grayscale
Artistic
Blur K
S (Cretcor:
Distort "l satwate...
Pixelate 3
Sharpen »
Sketch »
Stylize »
Texture 4
Video »
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4 The colors are inverted.

If an object is complicated,
part of colors may sometimes
be converted into a color
other than gray. In this case,
rasterize it to process it to a
gray-scale object (explained
in the next chapter), or select
only the object, and then exe-
cute [Convert to Grayscale]
again.

Save the image.

{3 Adobe lllustrator, - [SYIKOO3.eps @ 150% [CMYK/Preview) ] FEX
s‘! File Edit Object Iype Select Filter Effect Wiew Window Help - & X
150% _+ Seection v 4] L] »

B. Processing to gray-scale image by rasterizing

1 Select [Object] - [Rasterize...] from
the menu.

2 The “Rasterize” dialog box is dis-
played.

Select “Grayscale” from “Color
Model”.

When the “Background” is set
to “White”, the background
color becomes black by
inverting the colors. When
the “Background” is set to
“Transparent”, the back-
ground color remains white.

(ol Type Select Filter

Transform >
Arrange » L
Group Ctr+G
Ungroup  Ctrl+Shift+G
Lock >
Hide 4
Expand...
Elatkan Tranemavaneu
(= Select )
Slice >
Path >
Blend 4
Envelope Distort »
Clipping Mask »
Compound Path [
Crop Marks »
Graph »

Rasterize

Color Madel: |Grayscale |
Resoluti FRAVL 1
esolution
@_ Select
™ Sereen (7oNSemer H )_]

" Medium (150 ppi)
@ High (300 ppi)
" QOther: ppi

" Use Documnent Raster Effects Resolution

Background

" White @ Transparent

Options

Type Quality: [Streamline |
Anti-aliasing: [Art Optimized (Supersampling) ~ |
™ Create Clipping Mask

Add: [Dpt Around Object




Printing with only discharge liquid

3 The image 1s converted into a gray- {3 Adobe lllustrator - [SYIKO03.eps @ 150% (CMYK/Preview) ] 9(=1E3]
1 . ﬁﬁls Edit Object Iype GSelect Fiker Effect VWiew Window Help - & %
Scal€ 1mage. E =]
: —— m
. . . AR,
NOTE] At this point, all objects are AR
- integrated into a single raster ﬁ 5:
object. e —=
.\ Gt
\ "8, aal, |
o
4 2%,
 J 5,
A 2 o,
K\
\
[
=Hoo
[150% -] Selection >4 11| L’j
4 Invert the colors of the image. Effect View Window Help
| Apply Invert Colors  Ctrl+E
Select [Filter] - [Colors] - [Invert | InwertColors  CrAkeE | i PR
Aot Colrs..
Colors] from the menu. Croate v
Distort »
Pen & Ink »
Stylize »  Convert to CMYK
. Convert to Grayscale
Artistic
Blur 1
Erush Sirokes (Crovetcoes )
Distort " Satuate...
Pixelate 4 Select
Sharpen »
Sketch »
Stylize »
Texture 4
Video 4
5 The COlOI'S arc inverted. (3 Adobe lllustrator - [SYIK003.eps @ 150% (CMYK/Preview) ] 9(=1[E3]
ﬂ File Edit Object Iype Select Filter Effect Wiew Window Help -8 X
: 2]
Save the image. .
] x,
SR,
LA,
N\, =,
& 2.
"8, lal, B
5]
2%,
A
VAN
;
& al
Ol 2
Boo
[1s0% -] Selection v[4] ] L’ﬂ
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Raster Link Pro Il settings

This section explains the Raster Link Pro II settings.

Changing Printing Conditions

When using only the discharge liquid, set the Printing Condition, as listed below. For details
of the Printing Condition settings, see the Reference Guide.

1 Select a job for discharging, and then
open the Job Editor.

2 Open [Print Condition] of the Job Sop o0 o)

. Image Edit | Color Edit| Print Condition | Print Area
Editor st
- —
Sel “Di v fil z Bt
elect the “Discharge” profile. :
avD 2o i 1—
vz I 1 I
vz [ 1 |
2|~ @ Uni-direction
B v @ O Bi-direction

Overpint 12 limete)
Feed tall space FastPrint
@ & Pause Time per Scan|_0.0 % |sec @




Printing simultaneously with color image

Printing simultaneously with color image

Raster Link Pro Il settings

This section explains the Raster Link Pro II settings.

Job settings

The settings for printing the discharge liquid simultaneously with the color image are as fol-
lows.

1 Select a discharging job, and then
open the Job Editor.

Open the [Print Condition] menu of  ErrrErE—

. Image Edit | Color Edit| Print Condition | Print Area
the Job Editor.
—
> |4 [>v20 << | |~
T 360540 ND jv20 1 |

Select the “Textile Pigment CMYK”
profile.

720%720ND 2o
[720%720ND. hza

-
Pass N SpacialCobr v
e a
Feattaiopare [0 1Bhimets Dfastommt
o Time perscan| 0.0 eot

3 Open the [Image Edit] menu. R

Image Edit| Color Edit | Print Candition | Print Area

. . P 208 2 e
Specify the discharge liquid printing H 4 : I ——
. o, . osition Select rsor Key Unit1 v inch
method by “Discharge Composition”. ( SOIEDEENSET J_db
© Valid Bl 1
NOTE] When Discharge Compos.l- ]
tion” is not selectable, profile

for “Discharge” is selected in
the Inkset of [Print Conditon].
Select the profile for “Textile
Pigment CMYK”.
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Auto Discharge Composition

OFF : The discharge liquid is not-
printed.

Whole Image : The discharge liquid
is printed over the entire image (area
enclosed by dotted square in the pre-
view).

Valid Pixel : The discharge liquid is
printed only to the portions having a
color in the image.

Composite
Discharge Composition

Auto Discharge Compasition (&) OFF
{1 whole Image

) valid Pikel






MMimaki

D201560-1.00-16062006
Printed in Japan
© 2006 MIMAKI ENGINEERING CO., LTD. Allright reserved. IT



	About this User’s Guide
	Notice
	Table of contents
	Discharging method
	Printing only by discharge liquid
	Printing simultaneously with color image

	Printing with only discharge liquid
	Changing color of printed image for discharging
	Gray-scale image and finish

	Processing method for Photoshop
	Processing method for Illustrator
	Common operations
	A. Converting to gray-scale image with vector objects left as is
	B. Processing to gray-scale image by rasterizing

	Raster Link Pro II settings
	Changing Printing Conditions


	Printing simultaneously with color image
	Raster Link Pro II settings
	Job settings




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /ENU (Use these settings to create PDF documents with higher image resolution for high quality pre-press printing. The PDF documents can be opened with Acrobat and Reader 5.0 and later. These settings require font embedding.)
    /FRA <>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /KOR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe7f6e521b5efa76840020005000440046002065876863ff0c5c065305542b66f49ad8768456fe50cf52068fa87387ff0c4ee575284e8e9ad88d2891cf76845370524d6253537030028be5002000500044004600206587686353ef4ee54f7f752800200020004100630072006f00620061007400204e0e002000520065006100640065007200200035002e00300020548c66f49ad87248672c62535f0030028fd94e9b8bbe7f6e89816c425d4c51655b574f533002>
    /CHT <FEFF4f7f752890194e9b8a2d5b9a5efa7acb76840020005000440046002065874ef65305542b8f039ad876845f7150cf89e367905ea6ff0c9069752865bc9ad854c18cea76845370524d521753703002005000440046002065874ef653ef4ee54f7f75280020004100630072006f0062006100740020548c002000520065006100640065007200200035002e0030002053ca66f465b07248672c4f86958b555f300290194e9b8a2d5b9a89816c425d4c51655b57578b3002>
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


